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Cyber Security Legal Disclaimer 

This product is designed to be connected to and to communicate information and data via a 

network interface. It is your sole responsibility to provide and continuously ensure a secure 

connection between the product and your network or any other network (as the case may 

be). You shall establish and maintain any appropriate measures (such as but not limited to 

the installation of firewalls, application of authentication measures, encryption of data, in-

stallation of anti-virus programs, etc.) to protect the product, the network, its system and 

the interface against any kind of security breaches, unauthorized access, interference, intru-

sion, leakage and/or theft of data or information. ABB Ltd and its affiliates are not liable for 

damages and/or losses related to such security breaches, any unauthorized access, interfer-

ence, intrusion, leakage and/or theft of data or information. 

 

Risk Mitigation and Secure Deployment 

The idea is to create defence-in-depth protection for each network by allocating firewall solu-

tions to the front of internal trusted networks of each network by manage firewalls, their 

configurations and access rules. The softstarter must be positioned in a trusted network, 

strictly limited and in a hosted portion of a network or control system. Configure firewalls ac-

cording to the principle of denying everything that is not needed nor used. For secure remote 

access, use a VPN connection with an encryption layer to create a secure channel over an inse-

cure network. It is recommended to implement a rate limiter either at device or network level. 

For more information regarding cyber security and risk mitigation, download the document 

Cyber security for ABB drives from the ABB library. 

  

http://search-ext.abb.com/library/Download.aspx?DocumentID=3AXD10000492137&LanguageCode=en&DocumentPartId=1&Action=Launch
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1. CANopen 
CANopen is a higher layer protocol based on the CAN (Control Area Network) serial bus sys-

tem and the CAL (CAN Application Layer). CANopen assumes that the hardware of the con-

nected device has a CAN transceiver and a CAN controller as specified in ISO 11898. The CAN-

open Communication Profile, CiA DS 301, includes both cyclic and event driven 

communication, which makes it possible to reduce the bus load to minimum while still main-

taining extremely short reaction times. High communication performance can be achieved at 

relatively low baud rates, thus reducing EMC problems and cable costs. The physical medium 

of CANopen is a differentially driven two wire bus line with common return according to ISO 

11898. The maximum theoretical number of nodes is 127. However, in practice, the maximum 

number depends on the capabilities of the CAN transceivers used. Further information can be 

obtained from the CAN in Automation International Users and Manufacturers Group 

www.can-cia.org. 

The CANopen protocol provides full control and status information of the softstarter, reading 

as well as writing of parameters. It is possible to start and stop the motor, read out currents 

and frequency, get information about protections, warnings, faults and much more. See 

chapter 8 in the Installation and commissioning manual, document SFC132081M0201 for 

fieldbus related settings. 

Before the CANopen communication can be taken in operation following parameters must be 

set in the softstarter: 

– Parameter 12.2 FB interface connector set to Anybus. 

– Parameter 12.3 Fieldbus control set to On (This parameter can be set to Off if the fieldbus 

interface is only used to monitor the softstarter) . 

– Parameter 12.4 Fieldbus address set to an address between 1 and 127. 

– Parameter 12.9 FB baud rate set to a correct baud rate or auto. 

 

 

Information 

After changing any of the communication parameters it is needed to perform a 

power cycle of the device for the parameter values to be taken into effect. Or an-

other way for a communication parameter value change to be taken into effect is 

to set parameter 12.2 FB interface connector to “None” and then set it back to 

“Anybus”. 

 

 

To do the programming of the PLC, the following files are available: 

EDS file Type of file 

CANopen Anybus M40 PSTX Softstarter v1.1.EDS Electronic Data Sheet file 

 

  

http://www.can-cia.org/
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Information 

If there is no message passed between the PSTX softstarter and the Anybus 

module for more than the configured fieldbus failure timeout time (parameter 

19.12), the PSTX softstarter will trip on fieldbus communication failure protection 

(P1E00) and with the default configuration the motor will be stopped. If the com-

munication system is setup in such a way that commands/requests are not con-

tinuously passed between the PLC and softstarter, this protection function 

should be disabled. The parameter 19.4 (Fieldbus failure op) can then be set to 

“Off”. 

 

 

 

Caution! 

The motor may start unexpectedly if there is a start signal present when doing 

any of the actions listed below. 

– Switching from one type of control to another (fieldbus control/hardwire 

control) 

– Reset all Settings 

 

 

 

Information 

When fastening the module into the com1 port, make sure that the module is 

properly aligned in the socket prior to applying any force. Rough handling and/or 

excessive force in combination with misalignment may cause mechanical dam-

age to the module and/or the com1 and socket. 
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1.1. Anybus module 

The Anybus CompactCom PROFIBUS DP-V1 module is connected to the COM 1 interface on 

the PSTX softstarter. It can be used to control the softstarter, get status information, and to 

configure softstarter parameters. 

 

1.1.1. Front view 

Description of Connector and LEDs. 

# Item  

1 RUN LED 

 

2 ERROR LED 

3 CANopen interface 

 

If both RUN LED AND ERROR LED turns red, this indicates a fatal event; the bus interface is 

shifted into a physically passive state. 

1.1.2. RUN LED 

LED State Description Comments 

Off - No power 

Green OPERATIONAL The module is in the state OPERATIONAL 

Green, blinking PRE-OPERATIONAL The module is in the state PRE-OPERATIONAL 

Green, 1 flash STOPPED The module is in the state STOPPED 

Green, flickering Autobaud Baud rate detection in progress or LSS in pro-

gress (alternately flickering with ERROR LED) 

Red EXCEPTION state (Fa-

tal Event) 

The module has shifted into the state 

EXCEPTION 

 

1.1.3. ERROR LED 

LED State Description Comments 

Off - No power or the device is in working condi-

tion 

Red, single flash Warning limit reached A bus error counter reached or exceeded its 

warning level 
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LED State Description Comments 

Red, flickering LSS LSS services in progress (alternately flicker-

ing with RUN LED) 

Red, double flash Error Control Event A heartbeat event (Heartbeat consumer) has 

occurred 

Red Bus off (Fatal Event) Bus off 

 

1.1.4. CANopen interface 

Pin Signal 

1 -   

 

 

2 CAN_L  

3 CAN_GND  

4 -  

5 CAN_SHLD  

6 -  

7 CAN_H  

8 -  

9 -  

Housing CAN_SHIELD  

 

1.2. Software compatibility 

CANopen is supported from PSTX_CB v1.39.8. 
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1.3. Digital Inputs 

To PLC from softstarter. The input data is updated every 20 ms. 

 

1) Auto mode reflects the control state of the softstarter. This is affected by a combination of: 

– The Auto mode input signal from the PLC (Digital output telegram). 

– The state of the Local/Remote switch on the HMI. 

– The parameter “Fieldbus control”. 

– The digital input “Fieldbus disable”. 

Parameter Present in 

TPDO 

Bit Data Description 

BinaryInputByte1 

(Index=2003h, 

subindex=1) 

1 0 Auto Mode sta-

tus1 

0 = Softstarter control through 

fieldbus communication not al-

lowed 

1 = Softstarter control through 

fieldbus communication al-

lowed 

1 Event status 0 = No active fault/warn-

ing/protection 

1 = Active fault/warning/pro-

tection 

2 Ready to start 0 = A start will probably cause 

a fault 

1 = A start will not cause a fault 

3 FBT Response 0 See section 2 Fieldbus Tasks 

4 FBT Response 1 See section 2 Fieldbus Tasks 

5 FBT Toggle Bit See section 2 Fieldbus Tasks 

6 Programmable 

Digital Input 1 

Function of programmable 

digital input, see section 1.2 

7 Programmable 

Digital Input 2 

BinaryInputByte2 

(Index=2003h, 

subindex=2) 

0 Programmable 

Digital Input 3 

1 Programmable 

Digital Input 4 

2 Programmable 

Digital Input 5 

3 Programmable 

Digital Input 6 

4 Programmable 

Digital Input 7 

5 Programmable 

Digital Input 8 

6 Programmable 

Digital Input 9 

7 Programmable 

Digital Input 10 
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1.4. Programmable Digital Inputs 

The functions of the programmable Digital inputs are controlled by the parameters Fieldbus 

DI 1 through Fieldbus DI 10. The following functions are available for selection: 

Function Data 

None Value is set to 0 

Start feedback Status of Start signal 

Stop feedback Status of Stop signal 

Fault reset feedback Status of Reset signal 

Slow speed reverse feed-

back 

Status of Slow speed reverse signal 

Slow speed forward feed-

back 

Status of Slow speed forward signal 

Start 1 feedback Status of Start 1 signal 

Start 2 feedback Status of Start 2 signal 

Start 3 feedback Status of Start 3 signal 

Motor heating feedback Status Motor heating signal 

User defined feedback Status of User defined protection signal 

Stand still brake feedback Status of Stand still brake signal 

Emergency mode feedback Status of Emergency mode signal 

Start reverse feedback Status of Start reverse signal 

Run status 1 = Indicates when the softstarter gives voltage to the motor 

TOR status Top of Ramp. 1 = Indicates that motor runs on full voltage 

Line Line or Inside Delta Connection; 0 = Line, 1 = Delta 

Phase sequence 0 = L1, L2, L3; 1 = L1, L3, L2 

Event group 0 status 0 = No active events present in group 0. 

Event group 1 status 0 = No active events present in group 1 

Event group 2 status 0 = No active events present in group 2 

Event group 3 status 0 = No active events present in group 3 

Event group 4 status 0 = No active events present in group 4 

Event group 5 status 0 = No active events present in group 5 

Event group 6 status 0 = No active events present in group 6 

Sequence 1 Run status Run status of sequence connected motor 1 

Sequence 2 Run status Run status of sequence connected motor 2 

Sequence 3 Run status Run status of sequence connected motor 3 

Sequence 1 TOR status Top of Ramp status of sequence connected motor 1 

Sequence 2 TOR status Top of Ramp status of sequence connected motor 2 

Sequence 3 TOR status Top of Ramp status of sequence connected motor 3 

Run reverse status 1 = Indicates when the softstarter gives voltage to the motor 

after a reverse start 

Enable status Status of Enable signal 

Digital In0 status Status of internal digital input In0 
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Function Data 

Digital In1 status Status of internal digital input In1 

Digital In2 status Status of internal digital input In2 

Local control status 0 = Remote control, 1 = Local control (HMI) 

Cancel brake feedback Status of Cancel brake signal 

Pump cleaning auto status Status of automatic pump cleaning 

Pump cleaning forward sta-

tus 

Status of forward pump cleaning 

Pump cleaning backward 

status 

Status of reverse pump cleaning 

External digital 1DI0 status Status of external digital input 1DI0 

External digital 1DI1 status Status of external digital input 1DI1 

External digital 1DI2 status Status of external digital input 1DI2 

External digital 1DI3 status Status of external digital input 1DI3 

External digital 1DI4 status Status of external digital input 1DI4 

External digital 2DI5 status Status of external digital input 2DI5 

External digital 2DI6 status Status of external digital input 2DI6 

External digital 2DI7 status Status of external digital input 2DI7 

HW DI Start status Status of the hard wire internal digital input Start 

HW DI Stop status Status of the hard wire internal digital input Stop 

Ready to start (line contac-

tor) 

Same conditions as the Ready to start bit except that the in-

coming three phase voltage condition is excluded. The bit 

can be used when a line contactor is connected 

1.5. Analog inputs 

To PLC from the softstarter. 

All analog data is represented as 16-bit values. The input data is updated every 20 ms. 

A protocol for Fieldbus tasks is used to read and write parameters. It is applicable for all 

Fieldbuses. 

Parameter Present 

in TPDO 

Data Representation 

AnalogInputWord1 

(Index=2004h, subindex=1) 

1 FBT Return Value See section 2 Fieldbus Tasks 

AnalogInputWord2 

(Index=2004h, subindex=2) 

Programmable 

Analog Input 1 

Function of programmable 

analog input, see section 1.4 

AnalogInputWord3 

(Index=2004h, subindex=3) 

Programmable 

Analog Input 2 

AnalogInputWord4 

(Index=2004h, subindex=4) 

2 Programmable 

Analog Input 3 

AnalogInputWord5 

(Index=2004h, subindex=5) 

Programmable 

Analog Input 4 
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Parameter Present 

in TPDO 

Data Representation 

AnalogInputWord6 

(Index=2004h, subindex=6) 

Programmable 

Analog Input 5 

AnalogInputWord7 

(Index=2004h, subindex=7) 

Programmable 

Analog Input 6 

AnalogInputWord8 

(Index=2004h, subindex=8) 

3 Programmable 

Analog Input 7 

AnalogInputWord9 

(Index=2004h, subindex=9) 

Programmable 

Analog Input 8 

AnalogInputWord10 

(Index=2004h, subindex=10) 

Programmable 

Analog Input 9 

AnalogInputWord11 

(Index=2004h, subindex=11) 

Programmable 

Analog Input 10 

1.6. Programmable Analog Inputs 

The functions of the programmable analog inputs are controlled by the parameters Fieldbus 

AI 1 through Fieldbus AI 10. The following functions are available for selection: 

Function Representation 

None Value is set to 0 

Phase L1 current1 Value = 1000 ⇒ 100A 

Phase L2 current1 Value = 1000 ⇒ 100A 

Phase L3 current1 Value = 1000 ⇒ 100A 

Active power (hp) Value = 1000 ⇒ 10hp 

Active power Value = 1000 ⇒ 10kW 

Apparent power Value = 1000 ⇒ 10kVA 

Mains voltage Value = 1000 ⇒ 100V 

Power factor Value = 100 ⇒ 1 

Example: 87 ⇒ 0.87 

Motor voltage Value = 100 ⇒ 100% 

Active energy (resettable) Value = 1000 ⇒ 10kWh 

EOL time to trip Value = 100 ⇒ 100s 

Value = 65535 ⇒ No overload 

Value = 0 ⇒ Trip already occurred 

Mains frequency Value = 1000 ⇒ 100Hz 

Max phase current1 Value = 1000 ⇒ 100A 

Motor current Value = 1000 ⇒ 100A 

Motor run time (resettable) Value = 100 ⇒ 1000h 

Motor temperature Value = 100 ⇒ 100℃ 

Motor temperature percent Value = 100 ⇒ 100% 

Number of starts (resettable) Value = 1 ⇒ 100 

Phase sequence Value = 0 ⇒ L1->L2->L3 

Value = 1 ⇒ L1->L3->L2 

Value = 2 ⇒ No sequence detected 
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Function Representation 

PT100 temperature Value = n ⇒ n/10 – 50℃ 

Example: 750 ⇒ 25℃ 

PTC resistance Value = 100 ⇒ 100Ω 

Reactive energy (resettable) Value = 1000 ⇒ 10kVArh 

Reactive power Value = 1000 ⇒ 100kVAr 

Remaining time to start Value = 100 ⇒ 100s 

Thyristor temperature Value = 100 ⇒ 100℃ 

Thyristor temperature percent Value = 100 ⇒ 100% 

EOL time to cool Value = 100 ⇒ 100s 

Top event code Value = 1000 ⇒ 1000 

Motor current in percent of IE. Value = 100 ⇒ 100% 

Thyristor run time (resettable) Value = 1 ⇒ 10h 

Motor connection Value = 0 ⇒ auto 

Value = 1 ⇒ In-line 

Value = 2 ⇒ Inside delta – UI 

Value = 3 ⇒ Inside delta – IU 

Value = 4 ⇒ 2-phase L1 shorted 

Value = 5 ⇒ 2-phase L2 shorted 

Value = 6 ⇒ 2-phase L3 shorted 

Phase L1 current high range2 Value = 100 ⇒ 100A 

Phase L2 current high range2 Value = 100 ⇒ 100A 

Phase L3 current high range2 Value = 100 ⇒ 100A 

Active power (hp) high range2 Value = 100 ⇒ 100hp 

Active power high range2 Value = 100 ⇒ 100kW 

Apparent power high range1 Value = 100 ⇒ 100kVA 

Reactive power high range2 Value = 100 ⇒ 100kVAr 

Max phase current high range2 Value = 100 ⇒ 100A 

Max motor current high range2 Value = 100 ⇒ 100A 

Active energy high range2 Value = 1 ⇒ 10000kWh 

Reactive energy high range2 Value = 1 ⇒ 10000kVArh 

Number of starts (high precision) Value = 1 ⇒ 1 

 

1) Phase current L1, L2 and L3 indicate the current through the softstarter, while the Max 

phase current is always the line current. 

2) High Range alternatives are available for a few signals where there is a possibility for the 

values to wrap. The values are 16-bit so the maximum value for each signal is 65535. The High 

Range alternatives have different scaling and will never wrap around but instead have lower 

precision. 
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1.7. Digital outputs 

From PLC to the softstarter. 

Parameter Present 

in RPDO 

Bit Data Description 

BinaryOutbutByte1 

(Index=2001h, sub-

index=1)  

1 0 Start Commence a start when signal is set 

1 Stop Commence a stop when signal is ne-

gated 

2 Fault reset Reset signal for possible events 

3 Auto mode This must be set for controlling the 

motor 

4 Slow speed 

reverse 

Perform slow speed reverse when 

signal is set 

5 Slow speed 

forward 

Perform slow speed when signal is 

set 

6 Spare  

7 Start1 Start1 if sequence start 

BinaryOutbutByte2 

(Index=2001h, sub-

index=2) 

0 Start2 Start2 if sequence start 

1 Start3 Start3 if sequence start 

2 Motor heat-

ing 

Perform motor heating when signal is 

set 

3 Stand still 

brake 

Perform stand still brake when signal 

is set 

4 Start reverse Commence a reverse start when sig-

nal is set 

5 Spare  

6 Emergency 

mode 

Set to “1” to enable emergency mode 

7 FBT Toggle 

Bit 

See Fieldbus Tasks 

BinaryOutbutByte3 

(Index=2001h, sub-

index=3) 

0 User defined 

trip 

Set to “1” to trigger user defined pro-

tection 

1 Switch to re-

mote control 

Switch to remote control when signal 

is set 

(rising edge triggered) 

2 Pump clean-

ing auto-

matic 

Perform automatic pump cleaning 

when signal is set 

3 Pump clean-

ing forward 

Perform forward pump cleaning 

when signal is set 

4 Pump clean-

ing reverse 

Perform reverse pump cleaning when 

signal is set 

5 K4 relay 

command 

Set “1” to activate the internal K4 out-

put relay. Note that parameter 10.4 

K4 function has to be set as 

“Fieldbus” 



 FIELDBUS COMMUNICATION  

 

 

STATUS 

Approved 

SECURITY LEVEL 

Public 

DOCUMENT ID. 

1SFC132394M0201 

REV. 

C 

LANG. 

en 

PAGE 

14/30 

© Copyright 2024 ABB. All rights reserved. 

 

Parameter Present 

in RPDO 

Bit Data Description 

6 K5 relay 

command 

Set “1” to activate the internal K5 out-

put relay. Note that parameter 10.5 

K5 function has to be set as 

“Fieldbus” 

7 K6 relay 

command 

Set “1” to activate the internal K6 out-

put relay. Note that parameter 10.6 

K6 function has to be set as 

“Fieldbus” 

BinaryOutbutByte4 

(Index=2001h, sub-

index=4) 

0 1DO0 relay 

command 

Set “1” to activate the external 1DO0 

output relay. Note that parameter 

11.9 1DO0 function has to be set as 

“Fieldbus” 

1 1DO1 relay 

command 

Set “1” to activate the external 1DO1 

output relay. Note that parameter 

11.10 1DO1 function has to be set as 

“Fieldbus” 

2 2DO2 relay 

command 

Set “1” to activate the external 2DO2 

output relay. Note that parameter 

11.11 2DO2 function has to be set as 

“Fieldbus” 

3 2DO3 relay 

command 

Set “1” to activate the external 2DO3 

output relay. Note that parameter 

11.12 2DO3 function has to be set as 

“Fieldbus” 

4 Refresh pa-

rameters 

Restart fieldbus interface to refresh 

communication parameters 

5 Spare  

6 Spare  

7 Spare  
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1.8. Analog output telegram 

From PLC to the softstarter. 

All analog data is represented as 16-bit values. 

Parameter Present 

in RPDO 

Data Representation 

AnalogOutbutWord1 

(Index=2002h, subin-

dex=1) 

1 FBT Control 

Word 

This register is used to read parame-

ters (see fieldbus tasks) 

AnalogOutbutWord2 

(Index=2002h, subin-

dex=2) 

Fieldbus AO 1 

(FBT Argument 

2 or Internal an-

alog output) 

Parameter 12.37 Fieldbus AO1 decides 

the use of this register. If set as "FBT 

Argument 2”, it is used to write param-

eters and set time (see fieldbus tasks). 

If set as “Internal analog output” this 

value of this register controls the inter-

nal analog output. Note that parame-

ter 10.8 AO type needs to be set as 

“Fieldbus [%]” 

AnalogOutbutWord3 

(Index=2002h, subin-

dex=3) 

2 Fieldbus AO 2 

(FBT Argument 

3 or External 

analog output) 

Parameter 12.38 Fieldbus AO2 decides 

the use of this register. If set as "FBT 

Argument 3”, it is used to write param-

eters and set time (see fieldbus tasks). 

If set as “External analog output” this 

value of this register controls the ex-

ternal analog output. Note that param-

eter 11.14 1AO0 type needs to be set as 

“Fieldbus [%]” 

2. Fieldbus Tasks 
By using Fieldbus Tasks, it is possible to read/write parameters and to set the real-time 

clock.  

Which task to execute is selected by filling in the FBT Control Word. There are three signals 

for arguments to the task: 

– FBT Argument 1 is packed together with the Task ID in the FBT Control Word. 

– There are two additional 16-bit arguments in separate analog output signals, FBT Argu-

ment 2 and FBT Argument 3. 

To control when the task is executed, the digital output signal FBT Toggle Bit shall be 

changed. The softstarter will detect the change, execute the task, fill in the return values, and 

toggle the digital input signal FBT Toggle Bit as acknowledgement. Thus, the return values 

must be disregarded if the two toggle bits have different value. 
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2.1. FBT Control Word 

The control word is a 16-bit analog output value sent from the PLC to the softstarter. It con-

sists of a Task ID and an 11-bit argument packed together. 

15 14, 13, 12, 11 10, 9, 8, 7, 6, 5, 4, 3, 2, 1, 0 

- Task ID - Argument 1 

2.2. Task ID 

The task identifier controls which function should be performed. 

Task 

ID 

Task Response ID 

Positive Negative 

0 No task 0 - 

1 Request parameter value, lower word 1 2 

2 Change parameter value 1 2 

3 Set date and time 1 2 

4 Request parameter value, upper word 1 2 

2.3. Response ID 

The response ID is the softstarter response to a task. It tells whether a task was executed 

successfully. If there was an error, an additional error code is returned in the FBT Return Value 

analog input. The Response ID is transmitted as two digital input signals, FBT Response 0 

and FBT Response 1. 

Response ID FBT Response 1 FBT Response 0  Explanation 

0 0 0 No response 

1 0 1 Task executed 

2 1 0 Task cannot be executed (with er-

ror number) 

3 1 1 Reserved. 

2.4. Error codes 

The following error codes are sent when a task cannot be executed. 

Error code Explanation 

0 Illegal parameter number 

1 Parameter value cannot be changed 

3 Lower or upper limit violated 

4 Invalid argument 

5 No error 

6 Invalid task number 
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2.5. Request parameter value, lower word 

This task reads the lower 16 bits of the specified parameter’s value. See chapter 2.9 for pa-

rameter number and value scaling information. 

2.5.1. Arguments 

– FBT Argument 1: parameter number. 

2.5.2. Return Value 

– Response ID 1 and parameter value in FBT Return Value on success.  

– Response ID 2 and error number in FBT Return Value on failure. 

 

2.6. Change parameter value 

This task writes a specified value to a parameter. See chapter 2.9 for parameter number and 

value scaling information. 

2.6.1. Arguments 

– FBT Argument 1: parameter number. 

– FBT Argument 2: parameter value (lower word) 

– FBT Argument 3: parameter value (upper word) 

2.6.2. Return Value 

– Response ID 1 on success.  

– Response ID 2 and error number in FBT Return Value on failure. 

 

2.7. Set date and time 

This task updates the real-time clock on the softstarter. The date and time fields have the fol-

lowing limits: 

– Year: 0-63 (2000-2063) 

– Month: 1-12 

– Day: 1-31 

– Hour:0-23 

– Minute:0-59 

– Second:0-59 
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2.7.1. Arguments 

FBT Argument 2: year, month, day and least significant bit of seconds 

15 14, 13, 12, 11, 10, 9 8, 7, 6, 5 4, 3, 2, 1, 0 

s0 year month day 

 

FBT Argument 3: hour, minute, seconds, bit 1-5 

15, 14, 13, 12, 11 10, 9, 8, 7, 6, 5 4, 3, 2, 1, 0 

Hour minute seconds, bit 1-5 

2.7.2. Return Value 

– Response ID 1 on success. 

– Response ID 2 and error number in FBT Return Value on failure. In case the supplied time 

didn’t differ from the set time, error code 5 (no error) is used. 

2.8. Request parameter value, upper word 

This task reads the upper 16 bits of the specified parameter’s value. See chapter 2.9 for pa-

rameter number and value scaling information. 

2.8.1. Arguments 

– FBT Argument 1: parameter number. 

2.8.2. Return Value 

– Response ID 1 and parameter value in FBT Return Value on success. 

– Response ID 2 and error number in FBT Return Value on failure. 

2.9. Parameter numbers and values 

To access parameters from the fieldbus a unique parameter number is needed, this can be 

found in document 1SFC132081M0201, Chapter 7.25 Complete parameter list. Since the pa-

rameter values need to be represented as integers on the fieldbus, the parameter values with 

greater precision need to be scaled. In document 1SFC132081M0201, Chapter 7.25 Complete 

parameter list, there is a column specifying the number of decimals for each parameter. 

– Parameter values that are read from the fieldbus needs to be divided by 10numbers of decimals. 

– Parameter values that are written from the fieldbus needs to be multiplied by 10numbers of 

decimals. 

For example: 

The parameter Kick start time has parameter number 24 and 2 decimals. To read this param-

eter: 

1. Set FBT Task ID to 1. 

2. Set FBT Argument 1 to 24 to specify the parameter. 

3. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update. 
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4. Response ID 1 should now contain value 1, indicating success. 

5. FBT Return Value contains the value 50 (this is an example and depends on the actual 

value set). 

6. The return value should be interpreted as 50/102 = 0.5s. 

 

To change the Kick start time parameter to 1s: 

1. Set FBT Task ID to 2 for Change parameter value. 

2. Set FBT Argument 1 to 24 to specify the parameter. 

3. Set FBT Argument 2 to 1*102 = 100. 

4. Set FBT Argument 3 to 0 as 100 <= 65535 which means it doesn’t require more than 16 

bits. 

5. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update. 

6. Response ID 1 should now contain value 1, indicating success. 

 

2.9.1. Negative values 

Negative values are represented internally using 32-bit two's complement numbers. 

 

Example: 

Setting parameter 17.5 PT100 reset temp (parameter number 249) to a value of -25°C: 

The two’s complement of -25 is FFFFFFE7hex. The upper word is FFFFhex and the lower FFE7hex, 

in decimal notation 65535 and 65511. 

1. Set FBT Task ID to 2 for Change parameter value. 

2. Set FBT Argument 1 to 249 to specify the parameter. 

3. Set FBT Argument 2 to 65511 to specify the lower word. 

4. Set FBT Argument 3 to 65535 to specify the upper word. 

5. Toggle FBT Toggle Bit output and wait for the FBT Toggle Bit input to update. 

6. Response ID 1 should now contain value 1, indicating success. 

3. Configure ABB Automation Builder 
This section shows a demo about how to start and stop motor by sending commands using 

CANopen fieldbus protocol that is controlled by ABB AC500 Programmable logic controller 

(PLC) and CM598_CAN module. We use Automation Builder as an example platform and show 

the demo about building such communication setting. 
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3.1. Create a new project 

1. Open Automation Builder 

2. Select File->New Project->AC500 project->OK. 

3. Select the correct PLC CPU in Search object name …-> Add PLC. 

 

 
 

4. Check that the correct device type is selected by double clicking the device name in De-

vices field. 

 

 
 

 

5. Optional: rename the project and the Application to some more suitable names for exam-

ple “pstx” and “pstx_control”. 
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3.2. Install the EDS-file 

1. In the Tools menu select Device Repository. 

 

 
 

 

 

2. Click Install. 
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3. Select the EDS-file: CANopen Anybus M40 PSTX Softstarter v1.1.EDS. 

 

 

3.3. Add the CM598 CAN/CANopen master module 

1. Right click on the empty slot where the CM598 module is installed and select Add object. 

Then select CM598-CAN in the Replace object window. Click “Replace object” to close the 

Replace object window. 
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2. Select property baud rate, for example 125 kBit/s. 

 

 
 

 

3. Enter correct Node ID for the PLC master. Check “Enable Heartbeat Producing”. Set the 

Producer Time to 1000ms (1s). 
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3.4. Add the PSTX slave 

1. Right click on the CANopen_Master and select Add object. 

In the Add object dialog window select the PSTX Softstarter added in section 3.1 and click 

Add object 

 

2. Select correct Node ID for the PSTX softstarter slave. The node id corresponds to the Pa-

rameter 12.4 Fieldbus address in section 1. 

 

 
 

3. Select Enable Heartbeat Producing and set the Producer Time to 1000m. 

 

 
 

4. Click “Heartbeat Consuming”. Select Enable and change Consumer Time to 1200ms. 
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5. Disable RTR om transmit PDOs 

Right click on the Transmit PDO1 Communication Parameter and select Edit. 

 

 
 

In the PDO Properties deselect RTR and click OK. This must be done for all 3 Transmit PDOs. 

 

 
 

6. Map the signals to variable names. 
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3.5. Write a simple PLC program to control the softstarter 

We perform the following steps for building our start-stop demo program in CoDeSys. 

1. Open CoDeSys by double clicking your application in Devices file in Automation Builder,  

if it is not opened yet. 

 

 
 

 

2. Open program window by double clicking the default program in POUs in CoDeSys. 

 

 
 

 

 

3. We choose to use LD as the language of the POU here by right click POUs -> Add Object…-

>Insert Name of the new POU -> Choose “LD” for “Language of the POU” -> OK. 
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4. Select the first network, create a contact “START” (by CTRL+K and putting name at “???”) 

and two coils “digital_output_1.0” and “digital_output_1.1” (by CTRL+L) in first network. 

We let data types as default by clicking OK directly in Declare Variable window. We set dig-

ital_output_1 bit 0 and 1 because we want to set TRUE for “Start” and “Stop”, according to 

Section 1.7. The name digital_output_1 comes from end of Section 0 (map signals to varia-

ble names). 

 

 
 

 

5. Create a second network by CTRL+T. 

 

 
 

6. Select the second network, add a coil for automode “digital_output_1.3” (by CTRL+L). 

7. Now we want to create one control button for signing the value of “START” from the first 

network into TRUE. We do this by Visualization -> right click -> Add object -> Write name 

of the new Visualization as “view” -> OK. 
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8. We draw a shape as the button  -> double click the shape -> Regular Element Config-

uration -> Input -> check Toggle variable -> insert “demo.START” ->OK. 

 

 
 

9. We configure this program into task configuration by Resource -> Task configuration -> 

Right click Task configuration -> Append Task -> Insert t#10ms in Properties in Taskattrib-

utes. Then we need to sign our program to this task by right click NewTask-> Append Pro-

gram Call-> Choose demo(PRG) by clicking the select button in Program Call ->OK. 
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10. Right click on the NewTask and select Append Program Call. 

 

 
 

 

 

11. Select the demo program call 
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3.6. Build and run the PLC demo program 

Use the key, F11, to build the program once. Login and start project from Automation Builder 

by clicking Alt+F8 to login the CodeSys. Click yes to login. 

 

 

Click F5 to start. Switch to CoDeSys and click Alt+F8 to login demo. The program can be con-

trolled with the view from CodeSys. 

 

 

 

4. Contact us 
For more information, please contact your local ABB representative or visit 

https://solutions.abb/softstarters 

 

 

https://solutions.abb/softstarters

